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Executive Summary
Both in Australia and internationally, humanities, arts and culture (HAC) research, and cultural
heritage and curation, are at a pivotal juncture.
Changes in digital technology, ‘big data’, and associated developments are transforming
research practice in the humanities and arts. They are providing new ways to answer complex
questions about our society and culture, and our connections to and understanding of cultures
and communities around the world.
But in order to make new discoveries that will transform our understanding of our cultures,
identities, heritage and history, researchers require access to dispersed collections of qualitative
and quantitative data and advanced tools to enable data intensive research and analysis.
Much of the data that humanities and arts researchers need to undertake advanced research is a
combination of public sector data; data collected, managed and held by collecting institutions
(sometimes in partnership with private companies); data produced by individual researchers and
projects; as well as data collected and published by private institutions. This information is
largely ‘hidden’ from view, or in a variety of ‘unstructured’ formats – such as texts, maps,
artefacts, and audio-visual documents – or semi-structured formats in the case of research and
field records.
To underpin this transformation in research, this Data Summit provides a timely forum to map
and identify:
> characteristics and trends in HAC data, its storage, distribution, and use;
> users and beneficiaries of HAC data;
> how we imagine and plan for HAC digital infrastructures in Australia for the next 5-10
years;
> what principles, governance, and models best suit HAC national research infrastructures;
> what frameworks will provide the greatest impact for both researchers and users?
As this discussion paper outlines, the threshold problem lies in the lack of an agreed approach to
research infrastructure investment for humanities, arts, and culture. For this reason, we need:
> A national strategic plan to expand the uptake and development of innovative research
infrastructure;
> A large, collaborative, coordinated, interconnected ‘facility’ for humanities, arts and
culture research which addresses a broad national remit. This social research data
network – Integrated Research Infrastructures for Humanities, Arts and Culture
(IRIHAC) – would facilitate academic research and service as a public good resource
enabling all Australians to easily access cultural and social data/resources for a wide
range of social, cultural, economic, health, and environmental benefits.
Against the context of the current national research infrastructure landscape, the discussion
paper canvasses: what such integrated research infrastructures might deliver; principles for
design; framework for implementation and what steps this process entails.

Australian Academy of the Humanities, March 2018

2

The paper also provides key resources to underpin discussion: what HAC research and data
infrastructure do we have; where have HAC figured in past Australian national research
infrastructure roadmaps; what are useful models internationally and in Australia?

2

Discussion Questions
1. What are humanities, arts and culture (HAC) data?
2. Where are HAC data? What are our nationally-significant collections and reference data sets
for research? What are the significant privately-held archives and sets of data (e.g. social
media and Internet data)?
3. How does content and ‘unstructured’ data get transformed into (computational) research data
(through what curation processes) and then how does it get shared and re-used?
4. What kinds of HAC data are not currently well catered to, or fitting into, digital data,
computational and other technologies, and could these issues be addressed via future
National Research Infrastructure (NRI) design?
5. Who uses and benefits from HAC data?
6. How does data get interpreted and transformed into knowledge? How do research
communities derive value from the data? How do/can other users derive value from it?
7. How do we critically and ethically approach research data management?
8. What are the current and future possibilities for sharing, mining, and analysing HAC data,
including data linkage?
9. How might we build on, and leverage, the unique value of user, audience, and citizen
engagement in HAC institutions in a future NRI initiative?
10. What sorts of digital infrastructures and tools do we need now and over next 5-10 years?
11. What can be solved by generic solutions and where/when do we need bespoke or ‘domain’specific solutions?
12. What types of governance and institutional structures are needed to drive a national,
collaborative strategic initiative?
13. How do we maximise processes for design innovation, network building and resource
sharing?
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Introduction

3.1

Objectives
The Humanities, Arts & Culture Data Summit hosted by the Australian Academy of the
Humanities in Canberra 14-15 March 2018 will bring together researchers, policy makers and
institutions to discuss a national strategic approach to support future data-driven research and
drive step-change in the way researchers can discover, access, mine and analyse Australia’s
cultural and social data.
This Discussion Paper provides background to National Research Infrastructure (NRI)
investment across the broader Humanities, Arts and Social Sciences (HASS) domain and poses
a series of questions to help inform the future design of NRI initiatives.
Our Academy has been working with the Academy of Social Sciences in Australia (ASSA) and
galleries, libraries, archives and museums (GLAM) colleagues to outline a framework for
Platforms for HASS as part of the current National Research Infrastructure Roadmap and
investment process. The summit will be an opportunity to discuss and advance this work for the
Humanities, Arts and Culture (HAC) component of the Platform.
The aims of the summit are to:
> Progress a strategic agenda for national, collaborative NRI development for humanities,
arts and culture (connecting to social sciences and broader STEM system)
> Articulate the value proposition for a national scale infrastructure for the humanities, arts
and culture. What will it deliver for the range of national and international stakeholders?
> Determine a set of immediate priorities and next steps.
The key questions the summit will focus on are:
1. What is HAC data, what forms and formats does it take, how is it stored, transformed,
and distributed?
2. Who are the users and beneficiaries of HAC data? How can we best engage, connect,
and collaborate with HAC users and beneficiaries, across research, cultural heritage and
other institutions?
3. What does the HAC digital infrastructures landscape look like now and how might it
look in the next 5-10 years, from Australian perspectives?
4. What are the principles that might underline options for HAC NRIs? What might the
best architectures look like? What governance and infrastructural models could be fit for
purpose?
5. What is the best framework for defining and securing impact (research, social, cultural,
environmental, and economic)?

3.2

Brief snapshot of Humanities, Arts and Culture
Humanities, arts and cultural research, and its underpinning data, are a central part of a
knowledge-based economy, providing new frameworks for the analysis of humanity, and its
history, ideas, cultures, economies, languages and social structures. HAC research is a critical
partner to the social sciences and STEM fields in developing interdisciplinary solutions to

Australian Academy of the Humanities, March 2018

4

complex challenges such as climate change, social cohesion and belonging, new technological
development, future workforce solutions, resource management, health and welfare.
The broader Australian HASS research sector is large and diverse, comprising 41 per cent of the
university-based research system and more than 50 disciplines at the four-digit field of research
level, with fields ranging from economics, geography and demography, to languages, archaeology,
history, arts and media studies (see Mapping the Humanities, Arts & Social Sciences in Australia
report, 2014).

3.3

National Research Infrastructure Roadmapping
There have been four national infrastructure roadmaps, three of which have identified capability
deficits for HASS, see ATTACHMENT A. Although HASS capabilities were scoped in both the
2008 and 2011 Roadmaps, neither led to direct National Collaborative Research Infrastructure
Strategy (NCRIS) funding for a sector-wide NRI initiative.
The latest Roadmap, the 2016 National Research Infrastructure Roadmap was released in May
2017. The subject of extensive sector consultation, the Roadmap’s terms of reference called for
‘a framework to maximise the benefits of existing national research infrastructure built over the
last ten years and identify the next generation of research infrastructure that will optimise our
national science and research effort’ (p. 2).
National research infrastructure is defined by the Roadmap as comprising ‘the nationally
significant assets, facilities and services to support leading-edge research and innovation. It is
accessible to publicly and privately funded users across Australia, and internationally’ (p. 1).
The Roadmap identified the need for national-scale infrastructure for HASS – as one of nine
focus areas ‘that require ongoing support to ensure that Australia will be able to maintain its
position as an emerging or established global leader’:
> Digital Data and eResearch Platforms
> Platforms for Humanities, Arts and Social Sciences
> Characterisation
> Advanced Fabrication and Manufacturing
> Advanced Physics and Astronomy
> Earth and Environmental Systems
> Biosecurity
> Complex Biology
> Therapeutic Development
3.3.1.

Platforms for HASS

The Roadmap’s Platforms for HASS focus area prioritised three inter-related elements
(extracted from p.36):
> “Integrated and coordinated HASS platforms: Explore integration of networks for
coordinated access to physical collections and digital materials enabling the digitisation
of priority specimens across all collecting institutions. This could include the sharing of
Australian Academy of the Humanities, March 2018
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digitisation infrastructure and standardisation of best practice for processes and
interoperability with international research infrastructures.”
> “Harmonised platforms for Indigenous research: Explore integration of existing
institutional level capabilities across a range of data platforms: AIATSIS, ATSIDA
PARADISEC, and NCIG linked to wider platform for integration across all digital
collections and portals.”
> “Harmonised platforms for social sciences research: Explore integration of social
sciences data from multiple sources together with tools for analysis and visualisation.
This should be linked to the broader integrated and coordinated approach to a HASS
platform. Maintain priority for AURIN.”
In terms of the Roadmap’s characterisation of NRI development, Platforms for HASS falls in to
the following two categories (excerpted from Roadmap, p. 25):
> “Explore establishing: new greenfield investment should be explored as Australia does
not have existing or may have limited research infrastructure that can be enhanced.”
> “Explore integration: institutional or national research infrastructure already exists and
greater integration or new elements should be considered.”
It is envisaged that Platforms for HASS would also integrate with other areas of the Roadmap,
including eResearch and digital capabilities:
> Develop shared tools and services, including the coordination/sharing of digitisation
infrastructure and standardisation of best practice for processes and interoperability with
international research infrastructures.
> Improve research workforce development through data standards and protocols, data
management frameworks, digital skills development, and research training in digital
methods.
The Digital Data and eResearch Platforms priority area recommended the development of an
Australian National Data Cloud. The Department of Education and Training is currently
working with the Australian National Data Service (ANDS), Research Data Services (RDS) and
Nectar to bring these organisations under the one institutional umbrella later in 2018.

4

Platforms for HASS – development status
To support its consideration of the 2016 National Research Infrastructure Roadmap (the
Roadmap), the Government announced in the 2017-18 Federal Budget the development of a
Research Infrastructure Investment Plan (the Plan).
Unlike other areas of the Roadmap, Platforms for HASS is a national-scale infrastructure that
does not yet exist.
The Australian Academy of the Humanities (AAH) was approached by the Department of
Education and Training in July 2017 to lead an effort to inform the Plan for the ‘Platforms for
HASS’ priority area.
The Academy convened a Working Party to progress the scoping work requested by the
Department. Comprised of representatives from the Academy of the Social Sciences, GLAM
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and experts with an understanding of eResearch capabilities, the Working Party focussed their
efforts on three key areas:
1. An analysis of the current state of play, including an indicative inventory of existing
assets and infrastructures – including a number of NCRIS-funded facilities in the HASS
domain, and well developed infrastructure across universities and the cultural and
collecting institutions. See ATTACHMENT A.
2. A preliminary review of applicable models, including select NCRIS-funded facilities,
international infrastructures, and existing HASS platforms with NRI capability and
potential. See ATTACHMENT B .
3. A preliminary framework for two components of Platforms for HASS – comprising
Integrated Research Infrastructure for Social Sciences Culture (IRISS) and Integrated
Research Infrastructure for Humanities, Arts and Culture (IRIHAC).
Unfortunately due to the Department’s timeframes, AIATSIS was unable to be involved in this
stage of development. Our submission to the Department recommended a plan for consultation
and input on the third component of Platforms for HASS – harmonised platforms for Indigenous
research.

5

Integrated Research Infrastructures for Humanities, Arts and Culture (IRIHAC)
The following section is extracted and adapted from Platforms for HASS Strategic Framework
& Implementation Plan for an Integrated Research Infrastructure for Humanities, Arts and
Culture (IRIHAC): (i.e. that AAH delivered to Department of Education as part of investment
planning process in August 2017).
In Australia, the approach to research infrastructure investment for humanities, arts and culture
has not been strategic or informed by an agreed set of priorities across the system.
A national strategic plan is needed to realise the potential to expand the uptake and development
of innovative research infrastructure. E-research infrastructure and digitisation are the big areas
for growth and the strong collaborative approaches already existing in the HASS and GLAM
sector form a solid foundation for future development. This is one part of the puzzle.
The humanities, arts and culture sector needs a large, collaborative, coordinated, interconnected
‘facility’ which addresses a broad national remit – essentially a cultural and social research data
network which not only facilitates academic research but is also a public good resource enabling
all Australians to easily access cultural and social data/resources for social, cultural, economic,
health, and environmental benefit.
5.1.1.

Scale and diversity of humanities, arts and culture data

Changes in digital and ‘big data’ developments are transforming research practice in the
humanities and arts. In order to answer complex questions about our society and culture, and our
connections to and understanding of cultures and communities around the world, researchers
require access to dispersed collections of qualitative and quantitative data and advanced tools to
enable data intensive research and analysis. The discoveries they make will transform our
understanding of our cultures, identities, heritage and history.
Much of the data that humanities and arts researchers need to undertake advanced research is a
combination of public sector data; data collected, managed and held by collecting institutions
Australian Academy of the Humanities, March 2018
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(sometimes in partnership with private companies); data produced by individual researchers and
projects; as well as data collected and published by private institutions. This information is
largely ‘hidden’ from view, or in a variety of ‘unstructured’ formats – such as texts, maps,
artefacts, and audio-visual documents – or semi-structured formats in the case of research and
field records.
5.1.2.

Users and beneficiaries

A humanities and arts NRI would serve a large community of researchers – based on the
Australia Research Council’s latest Excellence in Research for Australia audit (2015), HASS
researchers comprise 41 per cent of the university-based system. The total university-based
research system is 43,589 FTE (67,579 headcount) of which HASS comprises 17,866 FTE (or
41 per cent of the total system). The Humanities and Creative Arts (HCA) component is 6,971
FTE which is 16 per cent of HASS. It is a diverse and distributed workforce.
Although designed initially to meet the needs of researchers, an IRIHAC has the potential to
service new communities and improve access to Australia’s cultural heritage nationally and
internationally. The NRI would have cross-disciplinary potential particularly in qualitative
social sciences, and in the STEM arena in areas where culture and science data needs to come
together for advanced analysis, for example in tackling climate change, disaster preparedness,
cybersecurity, and whole-of-life approach to healthcare delivery.
A humanities and arts NRI opens up possibilities for advanced education infrastructure to be
leveraged by educational institutions, contributing to the wider digital literacy agenda, and
broadening the skills and capacity development for students and researchers.
Data employed in HASS research is often culturally sensitive. Ethical, security and privacy
considerations apply with research relating to Aboriginal and Torres Strait Islander peoples, as
well as age-referenced data (especially relating to children), health data, and income data.
Protocols for the use and re-use of data are needed, noting the work already undertaken by
organisations such as AIATSIS (see Guidelines for Ethical Research in Australian Indigenous
Studies) and drawing on expertise developed in existing institutional infrastructures and in other
NRIs. There are a number of initiatives with regards to Indigenous Data Sovereignty underway,
including a symposium convened in Melbourne in October 2017 by the University of
Melbourne in partnership with AIATSIS.
In terms of integrating with Indigenous research platforms (in consultation with AIATSIS) the
lack of consistent cultural mapping for Indigenous Australia (both urban and rural areas) means
that we have yet to fully tap in to and learn from 50,000 years of land management and change.
Current science-funded infrastructure goes only a fraction of the way towards bringing the
complete picture in view – this new NRI would contribute to bringing biological and ecological
data together with language and cultural resources.
Key areas of policy alignment and impact include:
> Innovation, Industry and Science: National Innovation Science Agenda (specifically:
digital talent and skills, infrastructure collaboration, platforms for open data); Innovation
and Science Australia’s 2030 Strategic Plan for the Australian Innovation, Science and
Research System (including skills development, research end-user engagement); open data
and data-driven innovation (Prime Minister and Cabinet Public Data Statement, Data 61);
Digital Economy.
Australian Academy of the Humanities, March 2018
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> Education and Training: digital literacy and skills agenda
> Research: research workforce development, research engagement and impact, data
management (including Australian Research Council (ARC) policy)
> Arts, communications and culture: telecommunications, innovation infrastructure, GLAM
collections.
> Other policy areas where HAC makes an important contribution: health; disability policy
(e.g. NDIS); social and community services.
5.1.3.

Current NRI landscape

There are a number of National Collaborative Research Infrastructure Strategy (NCRIS) funded
facilities which provide some services to the HASS domain, and exemplary infrastructures
developed by pioneers in the humanities and arts research sector as well as those in Australia’s
cultural and collecting sector. These include Trove, which brings together into one platform
GLAM collections, as well as collections from universities, research and community
organisations; the ANDS/RDS/Nectar-funded HASS Data Enhanced Virtual Laboratory; and
domain-specific infrastructures such as PARADISEC, AustLit, AusStage, Australian Dictionary
of Biography, Design and Art Australian Online, Media History Archives, Papyri Macquarie,
Analysis and Policy Observatory (APO), Founders and Survivors, and the Prosecution Project.
Refer to ATTACHMENT A for an indicative inventory.
These infrastructures are largely operating at an institutional or project-based level, and the state
of play can be characterised as ‘ad hoc’ and uncoordinated. Existing platforms separately work
to standardise, harmonise and provide single points of access. They lack a combined set of tools
to power innovation in the way researchers analyse these combined datasets, and support for
new research methodologies.
5.1.4.

What would an IRIHAC deliver?

The development of IRIHAC would:
> Scale up interoperability across multiple existing infrastructures at the project,
institution, regional and national level to better support research needs and priorities at a
national-scale, collaboratively, strategically and in a coordinated way.
> Expand discoverability and access to data (physical and digital collections/materials) in
collecting and other research repositories, from existing discovery platforms onto a new
enhanced platform.
> Develop shared tools and services, including the coordination and sharing of digitisation
infrastructure, to drive innovation in research practice.
> Harmonise metadata capabilities, standards, practices and models for data management,
access, preservation and curation.
> Improve research data life-cycle management – translating unstructured/primary data
into discipline-specific datasets as a resource for scholarship, education and engagement,
and feeding these curated/enriched data back into the wider system for use by
researchers, business, industry and the general public.
> Build an interoperable digital repository in which primary research materials can be
housed and where metadata can be enriched over time.
Australian Academy of the Humanities, March 2018
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> Integrate and/or connect with other NCRIS facilities, sharing expertise and leveraging
investments.
> Improve research workforce development through promulgation of data standards and
protocols, data management frameworks, digital skills development, and research
training in new research methodologies.
> Coordinate national and international outreach and engagement – across the research
sector, collecting institutions, and communities and beneficiaries.
> Standardise best practice for processes and interoperability with international research
infrastructures.
> Work to locate datasets already created, especially those supported by public funds, and
to convert them to archival formats for future access.
5.1.5.

Principles for design

In building HASS research infrastructure, it is vital to learn from existing research infrastructure
initiatives and operational principles regarding approaches to sustainability/future proofing,
removing duplication, common services, and consolidating and clustering efforts. Broadly, the
following principles and attributes should apply:
> Commitment to engaging with multiple and diverse stakeholders: establish strong
stakeholder engagement across jurisdictions because challenges for research and the long
term retention of scholarly knowledge (in digital format) are inherently connected.
> Efficiency and reuse: utilise established research infrastructure and coordinate effort to
reduce duplication in the research infrastructure system.
> National scale: provide services that have a high impact, i.e. solving critical national
problems or enable critical mass exploitation levels i.e. serving a large proportion of the
research community.
> Internationalisation: incorporate in national research infrastructure a goal to be linked
into international networks.
> Domain specialisms: incorporate in national research infrastructure the need to increase
capacity for domain specific informatics and researcher training.
> Ensure accessibility of data and research outputs in accordance with FAIR principles
(findable, accessible, interoperable and reusable), with data open where possible but with
strong protocols for data protection and security where required.
> Deliver value for user communities [Refer to Canadian system for good strategic
frameworks on designing for benefit/impact, see https://www.innovation.ca/resultsimpacts ]
5.1.6.

Steps in the process

A framework for staged implementation would involve three key phases:
Phase 1: Establish a governance and advisory structure to include key stakeholders from the
research community and cultural and collecting institutions; conduct a capability/benchmarking
audit to assess future requirements of the humanities, arts and culture research sector; conduct
facilitation and consultation process to determine business plans, and governance and operating
Australian Academy of the Humanities, March 2018
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models. Governance needs to be informed by international developments to support
harmonisation and interoperability.
The consultation and facilitation process would work directly with other NRI capability and
existing NCRIS-funded facilities to determine the areas of overlap and leverage. The potential
of a specific program via the National Research Data Research Cloud (NRDC) would be
explored – to enable the development of tools and capabilities for humanities and arts
researcher-driven practice. In this context, it is worth referencing the work already underway
through an existing pilot project, the HASS Data Enhanced Virtual Laboratory: inclusive of a
data curation environment and interoperability framework; workbench for consolidated access
to existing toolkits and services (such as transcription, text analysis, and geocoding); a
publishing portal for HASS standards and workflows; and expansion of its current community
building program.
Phase 2: Prioritise areas for investment following the consultation phase and informed by
findings of the capability audit. The initial strategy will focus on infrastructure requirements,
technical consolidation and platform interoperability. This phase will utilise established research
infrastructure and coordinate effort to reduce duplication in the research infrastructure system,
while significantly scaling up capacity and driving efficiencies in the research process. It will
leverage existing infrastructures in service of humanities, arts and culture research (listed above)
and at ATTACHMENT B . It will identify any nascent infrastructures currently in development.
This phase would also seek to build on existing partnerships that constituent infrastructures have
with landmark international RIs to ensure that possibilities for interoperability and data sharing
are explored from the outset.
Two centralised facilities could also be explored in this phase:
> The establishment of a ‘digitisation excellence capability’, with one or two leading
repositories, in partnership with key research institutions, would ensure effective use of
innovative technology/cloud platforms and the flow of data for research.
> The establishment/consolidation of a text mining centre.
Phase 3: Build a linked infrastructure based on interoperability realised in Phase 2; using
cloud technology; further linking of distributed infrastructure and federated datasets across
locations and institutions; establish virtual laboratories for data searches and analysis,
visualisation of datasets, enabling researchers to add, retrieve and share data; provide virtual
workspaces for researchers and research groups; integrate digital methods and best practice
data management, analysis and archiving across the HASS sector more broadly; and complete
the data lifecycle by feeding research outputs back to systems that serve industry, government
and the public.

6

Next Steps: Towards a 5-10 year Strategy.
The summit will provide an opportunity to discuss proposed next steps. Initial suggestions
include:
> Version 2 of the discussion paper to incorporate input from the summit and form the
basis of a wider sector consultation strategy.

Australian Academy of the Humanities, March 2018

11

> Formation of an overarching alliance or coalition – a HAC Research Infrastructure
Alliance – to coordinate working papers and parties to advance the agenda, and to work
with social sciences and other parties towards a collaborative agenda for ‘Platforms for
HASS’.
> Develop use cases to evidence the ways in which researchers, institutions and a range of
beneficiaries would use and derive value from the development of HAC/HASS NRI.
> Develop pilot, ‘proof of concept’ projects.

Australian Academy of the Humanities, March 2018

12

ATTACHMENT A:
Past Australian National Research Infrastructure Roadmaps
2006 National Collaborative Research Infrastructure Strategy Strategic Roadmap
The 2006 Roadmap did not recommend a domain-specific HASS capability, reasoning that:
“As the needs for many of the specific enabling technologies (such as high-speed data
communications) are shared by all disciplines, investment in them is best managed on a
system-wide (rather than discipline-by-discipline) basis. This has particular ramifications
for the humanities and social sciences. In the Exposure Draft, two suggestions for research
infrastructure relating to the social sciences and humanities were canvassed (Development
of creative industries, digital content and applications, and Collaborative and strategic data
fusion and model interoperability). While the content of these suggestions is targeted to
the social sciences and humanities, the broad form of the proposed solutions (aimed at
providing an enhanced capacity to rapidly access, draw together, collaboratively consider
and interpret information from multiple sources) is relevant to all disciplines. Because
much (if not all) of what constitutes “research infrastructure” for the social sciences and
humanities are specific applications of generic platforms, the Committee considers that the
research infrastructure needs of these disciplines are best considered as part of a systemwide information management strategy.”
See
https://docs.education.gov.au/system/files/doc/other/national_collaborative_research_infrastruct
ure_strategic_roadmap_2006.pdf
2008 Strategic Roadmap for Australian Research Infrastructure
The Humanities, Arts and Social Sciences (HASS) had one capability mapped in the 2008
Roadmap, detailing a HASS-specific eResearch Infrastructure, managing data creation and data
management. It was envisaged that such a capability would address the sector’s need for the
creation, retention, management and collaborative use of data within and beyond the HASS
disciplines, and support a more collaborative and interdisciplinary approach to research.
The capability scoped a two stream piece of infrastructure – data creation and research material
digitisation, and data management and linkage. The Data Creation stream would see the
conversion of key primary research analogue data to digital form and the facilitation of
additional data for ongoing databases. The Data Management stream would enable data to be
interoperable, accessible and secure; include data modelling and analysis tools, visualisation
capabilities and collaborative tools and platforms; and provide networks to connect HASS with
other researchers.
It was proposed that the infrastructure be governed by a peak governance body, supported by
two representative reference groups aligning with the two streams of work.
The HASS capability did not receive any funding in the subsequent Budget.
See
https://docs.education.gov.au/system/files/doc/other/national_collaborative_research_infrastruct
ure_strategic_roadmap_2008.pdf
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2011 Strategic Roadmap for Australian Research Infrastructure
The third Roadmap covered 12 research outcome targeted capability areas, including a Culture
and Communities capability which was similar to the HASS capability described in the 2008
Roadmap. The 2011 Roadmap also included seven enabling capability areas, envisaged as crosscutting underpinning capabilities applicable to all disciplines. These included Digitisation
Infrastructure and eResearch Infrastructure capabilities.
The specific requirements detailed in the 2011 Roadmap for the Culture and Communities
capability included:
> protocols to ensure future data sets are Open Archival compliant;
> a variety of networking and access tools to facilitate the use of a diverse variety of data;
> tools with which to capture, analyse, visualise and interrogate the diverse types of data
available to the sector; and,
> virtual spaces for collaboration.
The Digitisation Capability was envisaged to increase the accessibility of data through the
digitisation of collections of artefacts, documents, films, animals, insects, plants and
genealogical samples.
See
https://docs.education.gov.au/system/files/doc/other/national_collaborative_research_infrastructure_st
rategic_roadmap_2011.pdf
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ATTACHMENT B:
Indicative Inventory of HASS Research and Data infrastructure
Extracted from PLATFORMS FOR HASS submission prepared for the Department of Education and
Training, August 2017
National Collaborative Research Infrastructure Funded:
> *Research Data Services (RDS) and eResearch South Australia (eRSA) Cultures and
Community Project
> *NeCTAR Virtual Laboratories (VL) – Alveo (the Human Communication Science VL)
and HuNI (Humanities Networked Infrastructure); and FAIMS (Field Acquired
Information Management Systems)
> Australian National Data Service (ANDS) – in particular the Open Data Collections
Program, the Major Open Data Collections Program (involving Australian Policy Online
[now Analysis and Policy Observatory (APO)]) and the Public Sector Data Program
> Population Health Research Network (PHRN) (for HASS health-related research)
> Australian Urban Research Infrastructure Network (AURIN)
> Australian Data Archive (ADA) (received NCRIS funding as ASSDA)
Other national infrastructures/facilities:
> *AIATSIS
> *Trove by National Library of Australia and NSLA (Repository of collaboratively
digitised and born digital full text content including Australian Newspapers,
Commonwealth and State Government Gazettes, digitised Australian Journals,
AGWA/PANDORA/Whole of Domain Archived Australian Websites)
> *National Archives of Australia
> *National Film and Sound Archive
> *National Museum of Australia
> *National Gallery of Australia
> *National Portrait Gallery
> *Australian War Memorial Collection
> *Other national, state and territory cultural and collecting institutions (archives, public
records offices, museums (collections and archives), galleries)
Collating/aggregating/analytical infrastructures/platforms with a national focus or
charter:
> *Trove (aggregating cultural heritage, research and community collections)
> *Australian Policy Online o Aboriginal and Torres Strait Islander Data Archive
(ATSIDA)
> Discovering ANZACs
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Pilots/regional /discipline-specific infrastructures and platforms (including those with a
national charter):
> *PARADISEC
> AustLit
> AustLII
> *Australian Dictionary of Biography
> *Australian Women’s Register
> *Encyclopaedia of Australian Science
> *Design and Art Australian Online
> *Obituaries Australia
> *Trove Identities Manager (minting of named entity persistent identifiers, colocation &
disambiguation of records from multiple sources)
> *Museum Victoria
> *Australian National Maritime Museum
> *AusStage
> *The Prosecution Project
> *Institutional Repositories, Open Journals and ePress open publishing platforms at
multiple Universities, Industry bodies, Health institutes & hospitals, state and federal
government departments
> *University archives (Wollongong, Monash, Melbourne, Newcastle, New England, etc.)
> *Local history and art collections hosted by Local councils/public libraries
> *Community collections hosted by volunteer museums, historical societies, clubs, RSLs,
religious bodies, army/navy/air force, schools
> *Other local government cultural and collecting institutions (archives, public records
offices, museums (collections and archives), galleries)
> Mobile Museum Project
> National Centre for Indigenous Genomics
> Social Health Atlas of Australia
> Queensland Museum
> Australian Museum
> Tasmanian Museum and Art Gallery
> South Australian Museum
> Western Australian Museum
> Museum and Art Gallery of the Northern Territory
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> Founders and Survivors
> Australian Centre for the Moving Image (ACMI)
> Museum of Contemporary Art Australia
> Art Gallery of South Australia
> Art Gallery of Western Australia
> QAGOMA
> Art Gallery of NSW
> National Gallery of Victoria
Australian Government resources
> Australian Bureau of Statistics (ABS) – e.g. Census data
> Australian Taxation Office
> HILDA – and other Department of Social Services / Department of Human Services
datasets
> Department of Education and Training data – sites like the National Centre for
Vocational Education Research, (NCVER), Federal schools funding
> State Government resources including Births, Deaths and Marriages etc.; Public Records
Offices
> *Parliamentary libraries e.g. Full text Press Releases from MPs databases, Hansard
> *ABC archives – e.g. RN broadcast segment transcripts
> *Australian Government Solicitor – Legal opinions
> Data.gov.au
> Department of Communications and Arts – including Bureau of Communications and
Arts Research; Australia Council Arts Participation Survey
* Indicates a Trove content or digitisation partner, or a Trove user/consumer
Key datasets include:
> The Australian population census and other important data sources.
> Longitudinal studies of individuals (such as the Household Income and Labour
Dynamics in Australia, Longitudinal Study of Australian Children and Longitudinal
Surveys of Australian Youth, funded by various Australian government departments).
> Nationally representative cross-sectional surveys such as the Australian Election Study
and Australian Survey of Social Attitudes, and periodic surveys by the Australian
Bureau of Statistics.
> Time series of economic and social phenomena such as unemployment, labour force
participation and other statistics produced from the ABS Labour Force Survey.
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> Administrative data collections such as the Research and Evaluation Database from the
Department of Employment and the Mortality data register from the Australian Institute
of Health and Welfare, and open data sources such as data.gov.au.
> Business data collections such as the historical records of firms and other organisations
held in locations such as the Butlin Archives and recent data from business activity and
records.
> Qualitative data collections such as the sub-studies from the Australian Longitudinal
Study on Women’s Health.
> Linked data such as that provided through the Population Health Research Network and
Australian Urban Research Infrastructure Network, and the Australian Census
Longitudinal Dataset.
> Full text historical media collections such as Trove’s digitised Australian Newspapers,
ABC transcript archives, the Australian Parliamentary Library’s Press Releases database.
An indicative list of HASS eResearch capacity developed through the last NCRIS round and
administered through ANDS, RDS or NeCTAR is detailed below. The proportion of these
‘HASS related’ projects would need to be viewed in the context of the total funding. The list
indicates that projects have leveraged or received a portion of funding through NCRIS, but in
the majority of cases these projects have been primarily funded through other sources ( for
example, Australian Research Council).
ANDS (x47)
Application
> Founders and Survivors: Genealogical Connections
Data Capture
> 3D Anthropological and Archaeological Data capture of 3D digital models and deposit
of metadata to Collection Repository
> Video data in the Social Sciences. Optimising Metadata Capture, Data Sharing
Procedures and Long-term Reuse
> Tools for curating and publishing research data in the form of media collections
(Multimedia Collections ARROW)
> Spatially Integrated Social Science
> Capture and publication of data on the history of adoption (History of Adoption)
> Papyri Data Capture
> Founders and Survivors Project
> Humanities and Social Science Research Data at the University of Melbourne
> UWA Rock Art Studies Data Management
> ANU-ANDS Data Capture Project - Humanities and allied disciplines
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Open Data
> *From Farms to Freeways: Western Sydney
> Campbell Howard Collection of Australian Plays Open Data
> *Triathlon in Australia Open Data Set
> *The Foley Collection
> The Flint Collection
> Extending the benefits of genome science to Indigenous Australians through appropriate
and respectful data sharing
> Data Hub of Australian Research in Marine and Aquatic Ecocultures
“Seeding the Commons” Data Management
> Reformatting the AusStage dataset to support access and re-use by researchers
> ATSIDA: Community tools and processes for effective data management planning
> Taking Australian Architectural and Built Environment Records into the Commons
> Reforming the Movies: the Motion Picture Producers and Distributors of America, Inc.
database
> Screen Media Research Archive
> UWS Seeding the Commons
> Archaeological Database Development: The People and Place Project
EIF, NEAT via ANDS
> Australian National Corpus
> Museums Metadata Exchange
> Aus-e-Stage – Collective Intelligence and Creative Visualisation for Collaborative
eResearch
> Increasing the availability and discoverability of Australasian legal research data
> PARADISEC: ExSite9
High Value Collections
> University of Melbourne Research Data Collections
> Transdisciplinary Digital Collections
> Connecting the Analysis and Policy Observatory Collections
> Bicycle Network
> Data on Elections, Democracy and Autocracy
> Increased Effectiveness of Free Online Access to Myanmar and Indian Case Law
> PARADISEC PNG Collections Data Enrichment
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> Data for the UTS Data Arena
> Angus and Robertson Collection for Humanities and Education Research
> JCU and Connected Urban Tropics
Collection Enhancement Partnerships
> NT Euthanasia Collection
> CCYP Wellbeing in Schools Project
> Digital Lives - Everyday Digital Literacies
> Fraser Island Collection
> Ngan’gi Language Collection
Connecting HVC and NCRIS Capabilities
> ANDS and AURIN Delivering High Value Services
Trusted Data Repository
> Australian Data Archives as Trusted Digital Repository for Australian Social Science
NeCTAR (x3)
> FAIMS (app)
> Alveo - https://nectar.org.au/labs/when-words-collide/ (lab)
> HuNI - https://nectar.org.au/labs/inspiring-cultural-collaboration/
RDS (x1)
> Access to Data for Culture & Community Research (storage)

A list of currently funded Australian Research Council (ARC) Linkage Infrastructure Equipment
and Facilities (LIEF) extracted from the LIEF Register at http://www.arc.gov.au/australiangovernment-investment-research-infrastructure is overleaf.
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Linkage, Infrastructure, Equipment and Facilities (LIEF) Register
Extracted from ARC LIEF Register available at http://www.arc.gov.au/australian-government-investment-researchinfrastructure NB not updated for latest LIEF round (projects funded for 2018)
University

Proposal Title & ID

Project
Leader

All Other Participating
Organisation(s)

Primary System(s)

Availability

QUT

TrISMA - Tracking
Infrastructure for Social
Media Analysis

A/Prof Axel
Bruns

•Curtin University of
Technology
•Swinburne University of
Technology
•Deakin University
•National Library of
Australia

–TrISMA: Tracking Infrastructure for
Social Media in Australia – tracking
Australian Facebook and Twitter
activities at large scale on an
ongoing basis

Item
available

Ms Kerry
Kilner

•The University of New
South Wales
•University of Wollongong
•The University of Sydney
•Monash University
•Flinders University
•The University of Western
Australia
•Queensland University of
Technology
•Australian Institute of
Aboriginal and Torres Strait
Islander Studies

–Online research Infrastructure

Item
available

Prof Gary
Foley

•Victoria University
•Deakin University
•The University of
Newcastle
•University of Technology,
Sydney
•The University of
Melbourne
•Te Whare Wananga o
Awanuiarangi
•University of Exeter
•The University of Waikato,
NZ
•National Museum of
Australia
•Old Parliament House

—On-line archive interface
—Audio-visual recording
equipment

TBA

Prof Andrew
Mowbray

•University of Technology,
Sydney
•The University of New
South Wales
•The University of
Melbourne
•The University of Sydney
•The University of Adelaide
•The University of
Queensland
•The University of
Newcastle
•La Trobe University

—Oracle Sun X5-2 server
—Oracle FS1 storage system
upgrades
—Oracle ZS3-2 NAS storage
upgrades

TBA

Prof Julian
Thomas

•RMIT University
•The University of Adelaide
•Victoria University of
Wellington, NZ
•RMIT Training Pty Ltd

–Online research infrastructure

TBA

LE140100148

University of
Queensland

The AustLit resource:
supporting research in
studies of Australian literary
and narrative cultures

LE130100131

Victoria
University

The Aboriginal History
Archive

LE170100116

UTS

Comprehensive free access
to Australian industrial and
workplace law

LE170100099

Swinburne
University

Linked data policy hub:
connected resources for
social research

Available for use by accredited
researchers at QUT and the partner
institutions

LE130100185
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Swinburne
University

Linked Data PolicyHub
Stage II: Urban & Regional
Planning &
Communications

Thomas, Prof
Julian

• RMIT University
• University of Canberra
• The University of
Melbourne
• The University of Sydney
• ANZSOG
• Internet Archive

–Data Infrastructure

Item
Available

Prof Kim
Vincs

•Deakin University
•The University of
Melbourne
•Monash University
•The University of New
South Wales
•RMIT University
•Swinburne University of
Technology
•University of South
Australia
•Queensland University of
Technology

Offsite Multi-configurable
Projection Mapping Kit, Portable
Indoor / Outdoor Optical Motion
Capture System, Wearable Tracking
Group Capture Kit, AR Group
Research Kit E34, Augmented
Studio for Body Annotation,
E27Mobile Locational Field Kit, 360°
Realtime 3D Laser Scanner Arena,
Creative Computing Studio Motion
Capture Augmentation, Sensilab
Virtual Heritage and Design Motion
Capture Lab, UAV Field Kit for Town
Planning, Design and Virtual
Production, Ambisonic Sound and
Vision Lab, Human Robot Sensory
Extension Lab, VR Group Research
Kit, EMG Kit, Vistuation
Workstations

TBA

Prof Graham
Greenleaf

•University of Technology,
Sydney
•The University of
Melbourne
•The University of Western
Australia
•Australian Catholic
University
•The Australian National
University
•The University of Sydney
•Bond University
•Monash University
•The University of
Queensland

–Oracle/Sun Fire X4470 Server
–Oracle ZFS Storage System ZS3-2
–Arista 7150S Switch and Licence

Item
available

Prof Ross
Harley

•The University of Sydney
•The University of
Melbourne
•University of Technology,
Sydney
•Deakin University
•The University of Adelaide
•University of Tasmania

– MongoDB (version 1.8.0-rc0)
– Django (version 1.3.1)
– PostgreSQL (version 8.4.9)
– jOAI (version 3.1.1.2)
– VM licences

Item
available

Dr Shawn
Ross

•The University of
Queensland
•The University of Sydney
•La Trobe University
•Flinders University
•Southern Cross University
•Intersect Australia Ltd
•Victorian Partnership for
Advanced Computing
•The Center for Digital
Antiquity
•University of California,
Berkeley
•The University of Chicago,
USA
•The University of York, UK

–Online Research Infrastructure
www.fedarch.org

Item
available

LE160100221
Swinburne
University

Collaborative embodied
movement design network

LE170100066

UNSW

The Australasian Legal
Scholarship Library: new
content and sophistication
for a world-leading legal
scholarship repository and
citatory

LE130100118

UNSW

Design & Art Australia
Online Research Tool:
enabling next generation eResearch in Australia's
visual and design cultures.

LE140100120
UNSW

Federated Archaeological
Information Management
Systems project:
Transforming
archaeological research
through digital technologies

LE140100151
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UNSW

The Australasian Legal
History Libraries: Stage II

Prof Graham
W Greenleaf

•University of Technology,
Sydney
•The University of New
England
•The University of Sydney
•University of Western
Sydney
•The University of
Queensland
•The Australian National
University
•University of Tasmania
•The University of Adelaide
•Griffith University
•Southern Cross University
•The University of
Melbourne
•University of Canberra
•The University of Notre
Dame Australia
•The University of Western
Australia

–Australasian Legal History Library

Item
available

Prof Sarah I
Kenderdine

•University of Western
Sydney
•RMIT University
•University of Canberra
•The University of Western
Australia
•University of Tasmania
•City University of Hong
Kong
•National Museum of
Australia
•Museum Victoria
•Australian National
Maritime Museum
•The Walter and Eliza Hall
Institute of Medical
Research
•AARNet Pty Ltd
•Intersect Australia Ltd

–An ultra-high resolution
experimental fulldome

Item not
available

Prof Abbas
Rajabifard

• The University of New
South Wales
• The University of
Queensland
• The University of Western
Australia
• University of Canberra
• University of Wollongong

–Data Infrastructure

Item Not
Available

Prof Harmen
Oppewal

•Swinburne University of
Technology
•The University of
Melbourne

–Tobii T120 Eyetrackers
–SR Research eye movement
systems
–Noldus Facereaders
–Affectiva Q-sensor wireless
wristbands
–NeuroSky Mindband
–Emotiv EPOC Mind-Reading
Controllers
–Quasar wireless dry sensor
headsets

Item
available

LE150100051

UNSW

DomeLab: an ultra-high
resolution experimental
fulldome

LE150100081

University of
Melbourne

Urban Analytics Data
Infrastructure

LE160100174

Monash
University

Behavioural research:
advanced exploration of the
mind

LE130100112
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Flinders

Visualising venues in
Australian live performance
research

Prof Julian
Meyrick

•The Flinders University of
South Australia
•The University of
Queensland
•The University of
Melbourne
•Monash University
•Deakin University
•The University of
Newcastle
•Edith Cowan University
•Griffith University
•Queensland University of
Technology
•The University of Sydney
•The University of New
South Wales
•La Trobe University
•University of Wollongong
•Victorian Arts Centre Trust
•State Theatre Company of
South Australia
•Performing Arts Heritage
Network of Museums
Australia
•Association of Performing
Arts Collections

—Software Engineering
—Ortelia 3D Modelling

TBA

Prof Michael
Christie

•The Australian National
University
•NT Department of
Education and Children's
Services

–Living Archive of Aboriginal
Languages

Item
available

Prof Michael
Christie

•NT Department of
Education and Children's
Services
•Northern Territory Library
•Catholic Education Office
of NT

–Living Archive of Aboriginal
Languages

Item
available

A/Prof
Cressida
Fforde

•The Australian National
University
•The Flinders University of
South Australia
•The University of
Melbourne
•University of Tasmania
•Australian Institute of
Aboriginal and Torres Strait
Islander Studies
•National Museum of
Australia
•University of Otago, NZ
•Association on American
Indian Affairs
•University of Amsterdam,
Netherlands
•University of Cologne
•Kimberley Aboriginal Law
and Culture Centre
Aboriginal Corporation
•Ngarrindjeri Regional
Authority Inc.
•Gur A Baradharaw Kod
Torres Strait Sea and Land
Council Torres •Strait
Islander Corporation
•Department of
Communication and the

—Computer hardware for KALACC,
GBK and NRA

TBA

LE170100003

Charles Darwin
University

A living archive of
Australian Indigenous
languages

LE120100016
Charles Darwin
University

A Living Archive of
Aboriginal Languages Stage II

LE140100063
Australian
National
University

Networked knowledge for
repatriation communities

LE170100017
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Arts

University of
Adelaide

An Australian Housing
Condition Data
Infrastructure

A/Prof Emma
Baker

• RMIT University
• University of South
Australia
• The University of
Melbourne
• Swinburne University of
Technology
•The University of New
South Wales

–Data Infrastructure

Item
Available

Dr Lee Arnold

• The University of Adelaide
• The Flinders University of
South Australia
• South Australian Museum
• Department of
Environment Water and
Natural Resources
• Defence Science and
Technology Organisation

–2 x luminescence readers (Risø
TL/OSL readers with single-grain
OSL modules)
–Low-level beta multicounter
system (Risø GM-25-5)

Item Not
Available

LE160100056

University of
Adelaide

A regional optical dating
facility in Australia

LE170100177
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ATTACHMENT C:
Select National and International Models
Extracted from PLATFORMS FOR HASS submission prepared for the Department of Education and
Training, August 2017
Population Health Research Network (PHRN
Proposition

Infrastructure

Organisations

Communities International

Processing &
Analysis

Interoperability and
domain informatics
Research tools
Facility network

University of Western
Australia (lead)

Research
Industry

IPDLN
Farr Institute

>

NCRIS governance and finance

>

Lead agency: University of Western Australia

>

Commonwealth investment: $20M NCRIS, $10M SS, $3.09M CRIS, $4.92M, $4.36M, $46.6M NCRIS

>

Total: $46.6M (Note: funding total goes past 2015 unlike the other NCRIS projects listed here where
figures are drawn solely from Dept. E&T statements dated 2015)

>

Funded: 2009 -

Platform as network
PHRN operates as a brokerage and provides critical national coordination. This national network includes state
based units that undertake secure data linkage to support research.
Community of practice (research and data collection)
PHRN provides specialised data curation services that support data integration and analysis.
Atlas of Living Australia (ALA)
Proposition Infrastructure

Organisations Communities International

Data
Access

CSIRO (lead)

Discovery platform
Interoperability and domain
informatics

Research
Collecting
Citizens

GBIF

>

NCRIS governance and finance

>

Lead agency: CSIRO

>

Commonwealth investment: $8.5M NCRIS, $30M SSI, $2.8M CRIS, $5.7M NCRIS. Total: $47M

>

Funded: 2013 -
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Platform as network
ALA infrastructure operates as a brokerage in a complex network of co-contributors and provides a critical
national bridging platform. The brokering and bridging characteristics (pulling effort collectively together into
a service node) affords national infrastructure system efficiencies through increased interoperability, data
availability, collaborative and co-investment.
Community of practice (research and data collection)
The priority for ALA is service of data and technology driven scientific research. Collaboration (in partnership
with the collecting sector) has enabled co-contribution through citizen science and transcription programmes.
Bioplatforms Australia (BPA)
Proposition

Infrastructure

Organisations

Communities International

Data Access
Processing &
Analysis

Discovery platform
Interoperability and
domain informatics
Research tools
Facility network

Bioplatforms
Australia Ltd

Research
Industry

Cancer
Moonshot

NCRIS governance and finance
>

Lead agency: Bioplatforms Australia Ltd

>

Commonwealth investment: $51M NCRIS, $50M SSI, $4.5M CRIS, $20.9M NCRIS. Total: $126.4M

>

Funded: 2013 -

Facility (as network of platforms and centres)
BPA infrastructure operates as a brokerage in a complex network of co-contributors and provides critical
national coordination. This network also includes facilities undertaking bioscientific and genetic data
collection related to research specialisms.
Community of practice (research and data collection)
BPA infrastructure provides research specific technologies to support data processing and analysis and
opportunities for collaborative research and offers training.
Trove
Proposition Infrastructure

Organisations

Communities International

Data
Access

National Library of
Australia (lead)

Research
Collecting
Citizens

Discovery platform
Interoperability
informatics

DigitalNZ
Europeana
Digital Public
Library of America

In addition to providing discovery and data access services Trove operates as a brokerage in a complex network
of large and small co-contributors and provides a national bridging platform for the humanities. The brokering
and bridging characteristics afford national infrastructure system efficiencies through increased interoperability,
data availability and collaboration. It also provides a shared long term digital repository for collaborative
digitisation. Trove provides discovery and data access services for a sub-group of HASS and science
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researchers seeking to use cultural heritage data, particularly written historical accounts, as an input to their
research.
Platform as community of practice (research and data collection)
Trove is based in the public sector and the API meets in part the needs of data and technology driven HASS
researchers (academic and citizen). Co-contribution is enabled through partnerships with other collecting
organisations (e.g. contribution of data to a single platform and collaborative digitisation of newspapers) and
the public transcription programme.
Australian Data Archive (ADA)
Proposition Infrastructure

Organisations

Communities International

Data
Access

Australian National
University (lead)

Research
Public

Discovery platform
Interoperability and
domain informatics

CESSDA

Platform as network
ADA has a long history of institutional support and established links nationally and internationally to broker
researcher access to data in social science data archives and government agencies.
Platform as community of practice (research and data collection)
ADA is a domain focused archive based in the research sector and provides data curation and access services
for a sub-group of HASS researchers seeking to deposit and reuse social science data as an input to their
research.
CLARIAH (Common Lab Infrastructure for the Arts and Humanities
Proposition

Infrastructure

Organisations

Communities International

Data Access
Processing &
Analysis

Interoperability and
domain informatics
Research tools
Facility network

Lead: university
Partners: universities,
GLAM, eResearch
capability for data

Research
Collecting

DARIAH
CLARIN

CLARIAH Proposal
Facility (as network of platforms and centres)
CLARIAH was created by consolidating existing infrastructure around language based research in HASS in the
Netherlands and leveraging research technologies already developed. Australian equivalents of this type of
existing infrastructure are: PARADISEC (and the Centre of Excellence in the Dynamics of Language) and
Alveo virtual laboratory (which holds the Australian National Corpus in the corpus collection and data
processing and analysis tools).
Platform as community of practice (research and data collection)
CLARIAH community of practice broadened to include more universities and heritage and public institutions,
including parliament and university libraries as partners. The domain focus for CLARIAH is: linguistics,
socio-economic history and media studies and the infrastructure investment focus is on common data types,
sustainable and long term data management, and sharing expertise and technologies (see work packages). A
joint CLARIN-Europeana initiative is aimed at establishing Europeana as Digital Service Infrastructure.
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ODISSEI (Open Data Infrastructure for Social Science and Economic Innovations)
Proposition

Infrastructure

Organisations

Communities International

Data Access
Processing &
Analysis

Interoperability and
domain informatics
Research tools
Facility network

Partners: universities,
public sector research,
eResearch capability for
data (DANS)

Research
Public

CESSDA
SHARE
ESS
GGP
SERISS

ODISSEI proposal
Facility (as network of platforms and centres)
ODISSEI builds upon a preexisting consortium of multiple research organisations from across the university
and public sector. The major aim of that consortium (and ODISSEI) is to increase infrastructure system
efficiencies (reduce fragmentation and overlap) and coordinate effort. Australian equivalents of this
infrastructure in universities are: ADA and longitudinal surveys and datasets such as HILDA, LSAY and ALSA
and public federal research agency equivalents would be: ABS, AIHW, and the departments of Social Services
and Education.
Platform as community of practice (research and data collection)
A shared aim in ODISSEI that operates across jurisdictions in the Netherlands is to draw the efforts of research
more closely to feeding into social policy directions and outcomes. From a practices perspective the
coordination of effort is designed to leverage more effectively the data and expertise in that community and
share common infrastructure such as surveys and panels.
DARIAH (Digital Research Infrastructure for the Arts and Humanities)
Proposition

Infrastructure

Organisations

Communities International

Data Access
Processing &
Analysis

Research tools
Facility
network

Pan-European (led
by France)

Research
Collecting

[via DESIR project
seeks Australian links]

Social & Cultural Innovation (ESFRI, p45)
>

ESFRI Roadmap entry: 2006

>

Preparation phase: 2008-2011

>

Construction phase: 2014-1018

>

Operation start: 2019

>

Legal status: ERIC, 2014

>

Capital value: 4,3 M€

>

Operation: 0,6 M€/year

>

HQ: Huma-Num (Paris, France)
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Facility (as network of platforms and centres)
DARIAH is a network of facilities, expertise and technologies in support of arts and humanities
research. DARIAH uses working group models to address shared challenges, e.g. research methods and
provenance, shares technologies, scholarly communication platforms and state of the art practices, runs event
and training programmes, and undertakes advocacy.
Platform as community of practice (research and data collection)
New initiatives indicate the move to build on relationships already established via the DARIAH community
and extend working relationships to establish stronger data management practices, partner with the cultural
heritage sector, scale up research infrastructure, and expand international links globally. The DESIR project
involves a move to consolidate data management practices and infrastructure (see DESIR Data Management
Plan); partner with EU cultural heritage initiatives e.g. Europeana and PARTHENOS, establish the Humanities
at Scale initiative and undertake liaison in other parts of the world (including Australia).
CLARIN (European Research Infrastructure for Language Resources and Technology)
Proposition

Infrastructure

Organisations

Communities International

Data Access
Processing &
Analysis

Interoperability and
domain informatics
Research tools
Facility network

Pan-European (led by
the Netherlands)

Research
Collecting

>

Social & Cultural Innovation (ESFRI, p45)

>

ESFRI Roadmap entry: 2006

>

Preparation phase: 2008-2011

>

Construction phase: 2011-2015

>

Operation start: 2012

>

Legal status: ERIC, 2012

>

Capital value: Not Available

>

Operation: 12 M€/year

>

HQ: Utrecht University, Utrecht, Netherlands

[UK & US
links]

Facility (as network of platforms and centres)
CLARIN in this phase of its development is aimed at consolidating data and technical infrastructure and
increasing their availability. See CLARIAH.
Platform as community of practice (research and data collection)
CLARIN is focused around language related data as a “carrier of cultural content” in research and heavy
emphasis is placed on the impact of stronger skills in data science having an impact on research. See
CLARIAH.
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European Time Machine/s
Proposition

Infrastructure

Organisations

Communities International

Data Access

Research tools

EPFL

Research

Processing &
Analysis

Facility
network

162 partners in 48
countries

Industry

FET
Flagship

The Venice Time Machine project runs 2012-2024 (European Commission) and is funded as via READ
Horizon 2020 - €8.2 million (7 project partners).
>

Phase I (2012-2016): Time Machine prototype

>

Phase 2 (2016-2020): EU university network

>

Phase 3 (2020-2024): EU city extension

The “Venice Time Machine” model has proved a significant and viable big humanities research platform, such
that city based city based Time Machines have been launched as new research platforms, ahead of the proposal
to secure EU FET Flagship funding (Amsterdam, Paris, Dresden, Nuremberg, Jerusalem, Budapest,
Naples). EPFL press release on FET Flagship.
The proposed extension of the Venice Time Machine into an FET Flagship involves the replication and
extension of the Time Machine model. The intention is to draw from the existing digital heritage data banks
(~2000 years) and advanced informatics developed, to further interpret, inference, and simulate cultural
knowledge, and to reconstruct the past using, using artificial intelligence and machine learning (where the
documentary records of early civilisation are sparse e.g. BCE).“Research and deployment of these components
can be envisioned as a collective European effort, creating a distributed infrastructure that could support the
creation of “Big Data of the Past” beyond the Venetian example.” Venice Time Machine Flagship (European
Commission). The proposed European Time Machine/s FET Flagship (€1 billion in funding over ten years for
large-scale research initiatives) has extensive European coverage and collaboration with multiple research
infrastructures, programs, universities and cultural institutions:
>

International: IIIF Consortium, 15cBOOKTRADE, Fragmentarium, FRIDA

>

EU: Europa Nostra, Europeana, Archives Portal Europe, DARIAH, EuroSDR, ICARUS, CERL,
READ, EAUH, E-RIHS, PostData,

>

National: CLARIAH, Golden Agents, CREATE

>

Institutional: MAPIRE

Facility (as network of platforms and centres)
The European Time Machine/s research platforms (including the Venice Time Machine) operate (pre or post
FET Flagship funding) as a network of peers and co-contributors, providing pan-EU and international
coordination of a complex ecosystem of domain specific research and data infrastructures that support
humanities and arts research. The network includes facilities undertaking diverse types of humanities and arts
research requiring a range of heritage data collection, advanced informatics and visualisation tools for data
analysis.
Platforms as communities of practice (research and data collection)
The distributed Time Machines operate as large scale simulators as nodes in a network that support research
investigations into 2000 years of European history. The Time Machines provide research specific technologies
to support data processing and analysis and opportunities for collaborative research and training. Data is drawn
from co-located heritage collections into research infrastructure, and enhanced with advanced informatics to
enable research computation.
The ‘time machine’ reconstructing ancient Venice’s social networks, 14 June 2017, Nature, Alison Abbott.
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